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Disclaimer 

This workspace is being provided under the same disclaimer as found at the web 
page MDOT SHA CAD Standards Disclaimer. 

The workspace itself contains two (2) different CAD standards. The first, “SHA V8 
01”, is identical to the old CAD standard (MDSHA V8 01) in every meaningful way 
and is intended to provide backwards compatibility for existing projects. The new 
CAD standard, “SHA V8 02”, has significant changes and has been customized 
specifically for use with InRoads/OpenRoads SELECTseries 4 (SS4). (Note that the 
V7 CAD standard is no longer included in this workspace.) 

2004 Workspace 2019 Workspace 
Standard Version Standard Version 

MDSHA_V8_01 01.01.15a SHA_V8_01 01.02.03 

  SHA_V8_02 02.01.03 

As with the old workspace, the new workspace can be integrated for use with SHA’s 
ProjectWise unmanaged workspace profile on SHAEDMS01. Please read the 
installation instructions carefully, as the steps have changed. A significant amount 
of internal testing has been performed using this workspace, but every firm’s 
implementation of the current workspace is most likely unique and may reveal 
problems that MDOT SHA has not encountered.  

This release is no longer considered Beta, however any firm that has not performed 
any testing during the Beta phase should consider the recommendations and tips 
specified in this document. 

It is strongly recommended that a special test area be created to allow experienced 
users to test the workspace in a manner that allows them to return to the previous 
workspace if necessary. See FAQ #12 below for ideas on implementing the new 
workspace for specific users only.  

  

https://www.roads.maryland.gov/Index.aspx?PageId=31
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Requirements 

The new workspace has been tested with the following software versions 
(recommended versions in bold): 

Windows 7: 

• ProjectWise Explorer 08.11.11 (V8i SS4) 

• MicroStation 08.11.07 (V8i SS1) 

• MicroStation 08.11.09 (V8i SS3) 

• Power Inroads 08.11.07 (V8i SS2) 

• Power Inroads 08.11.09 (V8i SS4) 

Windows 10: 

• ProjectWise Explorer 10.00.03.280 (CONNECT) 

• MicroStation V8i (SELECTseries 10) V8.11.09.919 

• MicroStation V8i (SELECTseries 3) V8.11.09.459 – Update 2 
o  or V8.11.09.357 – Update 1 
o  or V8.11.09.292 – Initial Release 

• InRoads V8i (SELECTseries 10) V8.11.09.912/918 

• Power InRoads V8i (SELECTseries 4) V8.11.09.904 

• Power InRoads V8i (SELECTseries 2) V8.11.07.615 
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Setup Instructions 

NOTE:  Setup Instructions have changed from the previous workspace! 

 We recommend preserving your old workspace until you are 
confident that the new one is operational and meeting your needs. 
THAT MEANS SAVING THIS WORKSPACE TO A NEW LOCATION.  

This zip file contains a new MicroStation Workspace configured with two different 
SHA CAD Standards: 

• SHA_V8_01 (equivalent to old MDSHA_V8_01) 

• SHA_V8_02 (configured especially for InRoads SS4) 

Follow these steps to install and use the workspace: 

1. Establish a directory where you want to maintain your SHA workspace.  This 
can be either a local or network path. We recommend: 

  e.g. C:\ProgramData\Bentley\MDOT\ 

(Don’t see the ProgramData folder? Read the FAQs) 

2. Extract the zip file to the above location. A new folder named "Workspace" 
is created - this is your "workspace root directory". 

  e.g. C:\ProgramData\Bentley\MDOT\Workspace\ 

3. Open the following file in a text editor like Notepad:  

..Workspace\config\ProjectWise\Configuration\mcm.user.cfg 

    and edit the "_MDOT_WORKSPACEROOT" variable to match your actual  
workspace root: 

_MDOT_WORKSPACEROOT = C:/ProgramData/Bentley/MDOT/Workspace/ 
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NOTE: The config variable path MUST END WITH A FOREWARD SLASH (/) 
after the "Workspace" folder (see example above) 

4. The remaining steps are different than previous workspace instructions!  

 

5. Create a new desktop shortcut for MicroStation and/or Power InRoads 

6. Right-click the shortcut and select Properties... 

7. In the Target field, go to the end of the existing text, then ADD a SPACE, then 
APPEND one of the following command-line switches, depending upon the 
CAD Standard version you wish to use: 

Application Target Switch 

InRoads SS2 
Power InRoads SS2 

-ws_MDOT_STANDARDNAME=SHA_V8_01 

Modified 

mcm.user.cfg 

Is ProjectWise 

Installed? 

COPY the modified CFG to 
$(_USTN_APPL) and RENAME  

the file SHA.cfg 

YES 

COPY the modified CFG to 

$(ALLUSERSPROFILE)\Bentley\ 

ProjectWise\Configuration\ 

NO 

WARNING: Do not overwrite file if it 

already exists! For this case and other 

questions, please read the FAQs 

A B 

Proceed to Step 5 

Questions or problems? Read the FAQs 
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MicroStation (All versions) 

InRoads SS4 
Power InRoads SS4 
MicroStation (All versions) 

-ws_MDOT_STANDARDNAME=SHA_V8_02 

 

8. Click OK to save the changes to the shortcut.  Double-clicking the shortcut 
should launch the application into the new SHA workspace with the following 
defaults: 
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Note that the CAD Standard version is now tied to the Project PCF. While it 
is possible to switch the Project from the application's File Manager before 
opening a file, changes will not be preserved. Therefore, it is recommended 
to create separate shortcuts for each CAD standard version as needed. 

FAQs 

1. What are the similarities and differences between the two installation 
methods in Step 4? 

Similarities: 

• Both methods yield identical configurations. 

• Both methods can be used inside SHA’s ProjectWise environment without 
further customization. (Note that the old SHAPW.cfg is no longer necessary). 

Differences: 

• Method 4A (..\ProjectWise\Configuration\mcm.user.cfg) will provide an SHA 
workspace to all Bentley applications on the computer, AS LONG AS each 
application is integrated with ProjectWise. (Note that ProjectWise does not 
actually have to be used. Each application will however need a custom SHA 
Workspace shortcut per steps 5-8). 

• Method 4B (..\[Application]\config\appl\SHA.cfg) must be repeated for each 
CADD application.  However, ProjectWise is not required to be installed. 

• Method 4A can be installed without administrative permissions. 

• Method 4B typically requires administrative permissions   

2. I followed the ProjectWise instructions (Step 4A), but the new Workspace doesn’t 
load… How do I troubleshoot? 

2.1. Are you sure ProjectWise is installed? 
2.2. Is ProjectWise integration enabled for your application? 
2.3. If the answer to both is yes, generate a debug file (See FAQ 7) and use 

CTRL+F to check the following… 
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a. _MDOT_STANDARDNAME is set (SHA_V8_01 or SHA_V8_02). If not, 
the problem is in the Target field of your shortcut 

b. There are references to “mcm.user.cfg”. (If done correctly, there 
should be references to at least two different paths).  If there are no 
references, then your CADD application is probably not integrated 
with ProjectWise (see here). 

c. _MDOT_WORKSPACEROOT is set (and set correctly). If this variable is 
not set, something is likely wrong with the placement of your custom 
mcm.user.cfg file (see here and here). 

3. I followed the non-ProjectWise instructions (Step 4B), but the new Workspace 
doesn’t load… How do I troubleshoot? 

3.1. Did you place the SHA.cfg file in the correct appl folder corresponding to 
your application shortcut? (A computer with multiple applications and 
versions will have a separate appl folder for each). 

3.2. If so, generate a debug file and use CTRL+F to check the following… 

a. _MDOT_STANDARDNAME is set (SHA_V8_01 or SHA_V8_02). If not, 
the problem is in the Target field of your shortcut 

b. _MDOT_WORKSPACEROOT is set (and set correctly). If this variable is 
not set, something is likely wrong with the placement of your custom 
SHA.cfg file (see here). 

4. The shortcut launch crashes with message “Exiting, _USTN_USERCFG … not 
found”, leaving a text window displayed. 

4.1. Your _MDOT_WORKSPACEROOT path declaration is most likely wrong. 
Take a closer look at the file path in the message… 

_MDOT_WORKSPACEROOT = C:\CADD\Workspace\ 
 

wrong slash used 

_MDOT_WORKSPACEROOT = C:/CADD/Workspace 
 

missing the last (/) 

_MDOT_WORKSPACEROOT = C:/CADD/Workspace/ 
 

correct! 

_MDOT_WORKSPACEROOT = C:\CADD\Workspace/ 
 

last one matters most! 
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4.2. Are any folder names concatenated?  If so, you have either used a trailing 
backslash (\) instead of a forward slash (/) at the end of the path 
declaration, or else have no slash at all:  

4.3. Is the drive letter missing? In fact, most of the path missing? (e.g. “Exiting, 
_USER_USERCFG = Users\untitled.ucf not found…”). In this case, check 
the spelling of _MDOT_WORKSPACEROOT. The variable has most likely 
been accidentally misspelled (“_MDSHA_”??) or deleted, and therefore 
dependent variables like _USTN_USER will be corrupted. 

5. How do I determine if ProjectWise is installed? 

5.1. Open Control Panel … 

5.2. Look for ProjectWise V8i Network 
(Win 7) or ProjectWise Network (Win 
10) 

If you find this, ProjectWise is installed. 

6. How do I determine if my application is integrated with ProjectWise? 

Generally speaking, an application is integrated if you can browse ProjectWise 
from within the application. If a CADD application has been installed AFTER 
ProjectWise was installed, iDesktop Integration may need to be enabled: 

6.1. Open Control Panel…  
6.2. Open Programs and Features… 
6.3. Select ProjectWise Explorer and select Change/Modify > iDesktop 

Integration 
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Windows 7, ProjectWise Explorer V8i setup… red “X” indicates application is 
not integrated with ProjectWise… To fix, click the “X” and select “this feature 
will be installed on local hard drive”. 

 
Windows 10, ProjectWise Explorer CONNECT setup… check mark indicates 
that the application is integrated. 

7. How do I generate a debug file? 

7.1. Copy and paste the new shortcut and rename it “SHA DEBUG”  
7.2. Right-click the SHA DEBUG shortcut and select Properties… 
7.3. In the Target field, APPEND a space followed by “-debug” (without 

quotes) 
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7.4. Click OK to save the changes, then launch the shortcut… 
7.5. When the text stops scrolling, find the msdebug.txt file path shown at the 

end of the configuration variable summary. 

8. Where is C:\ProgramData\Bentley\...? 

The “ProgramData” folder is often hidden. Follow these steps to view hidden 
items: 

8.1. In Windows File Explorer, select File > Change folder and search options. 
8.2. Select the View tab 
8.3. Toggle the option to “Show hidden files, folders and drives” 
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8.4. Click OK. 

Still can’t find C:\ProgramData\...? Refer to the next FAQ… 

9. Where is $(ALLUSERSPROFILE)? 

Typical path is C:\ProgramData… if this folder exists along with a Bentley 
subfolder, you found it.  If not, try the following steps to determine the path: 

8.5. Launch the CAD program... 
8.6. Select Utilties > Keyin... 
8.7. Keyin: expand echo $(ALLUSERSPROFILE) 
8.8. Open the Message Center to reveal the path 
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9. Where is $(_USTN_APPL)? 

Typical path is:  

C:\Program Files (x86)\Bentley\[App+Version]\[Application]\config\appl 
 
If you can’t find it, try the following steps to determine the path: 

9.1. Launch the CAD program... 
9.2. Select Utilties > Keyin... 
9.3. Keyin: expand echo $(_USTN_APPL) 
9.4. Open the Message Center to reveal the path: 

e.g. C:\Program Files (x86)\Bentley\MicroStation V8i (SELECTseries)\MicroStation\config\appl\ 

10. What if I can’t write to $(_USTN_APPL)? 

This directory falls under Program Files and therefore typically requires admin 
permissions. If this is a problem, you can try placing the renamed file (SHA.cfg) 
in your corporate $(_USTN_SITE) directory. While this should still work, you may 
find that various aspects of your corporate workspace are now mixed with the 
SHA workspace, which may or may not be desirable. 

If the result is undesirable, the workspace also includes a startup.cfg file located 
in ..\Workspace\config\startup that can be configured and referenced using the 
shortcut Target method employed by the previous workspace: 

Application Target Switch 
InRoads SS2 
Power InRoads SS2 
MicroStation (All versions) 

- wc“[WorkspacePath]config\startup\startup01.cfg” 

InRoads SS4 
Power InRoads SS4 
MicroStation (All versions) 

-wc“[WorkspacePath]config\startup\startup.cfg” 

Where [WorkspacePath] should be replaced with the full Windows path to your 
SHA workspace folder, for example: 

-wc“C:\MDOT\Workspace\config\startup\startup.cfg” 
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11. What if I can’t find the directory:  
  $(ALLUSERSPROFILE)\Bentley\ProjectWise\Configuration 

That is perfectly normal! While the Bentley subfolder should exist, the 
ProjectWise\Configuration subdirectories are not created during installation 
and must be created manually. To avoid spelling mistakes, try copying and 
pasting the directories (along with the modified mcm.user.cfg) from the 
provided SHA Workspace\config folder. 

12. What should I do if the mcm.user.cfg file already exists? 

You should edit the existing file rather than saving over it.  However, before you 
do so, first doublecheck that the path is correct… 
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NOTE:  The mcm.user.cfg file is found in several locations! Specifically: 

C:\Program Files (x86)\Bentley\ProjectWise\bin\  

C:\ProgramData\Bentley\ProjectWise\Configuration\ 

C:\Users\[username]\AppData\Local\Bentley\ProjectWise\Configuration\ 

The first path file is delivered by Bentley and should NOT be overwritten!  

 
Your custom mcm.user.cfg should be placed in EITHER the second path (to apply 
to all user profiles) OR the third path (to apply to a specific user). 

However, if a file exists in either of those locations, it must have been 
customized for your office.  Therefore, you should open the file and compare 
the contents against those of the new file… assuming that the contents do not 
match, APPEND the contents of the new file to the end of the existing file. 

13. Rather than create a special shortcut, is it possible to incorporate the SHA CAD 
standards into my existing corporate workspace? 

Yes. Now that the standards are project-based, they can be readily applied to 
your existing Project PCF files. With the mcm.user.cfg file (or SHA.cfg file) in 
place, copy the following lines into your PCF file: 

To implement the old (SHA_V8_01) standard: 

_MDOT_STANDARDNAME = SHA_V8_01 

_MDOT_STANDARD = $(_MDOT_WORKSPACEROOT)Standards/$(_MDOT_STANDARDNAME)/ 

%if exists ($(_MDOT_STANDARD)*.cfg) 

%   include $(_MDOT_STANDARD)*.cfg 

%else 

%   error Exiting, $(_MDOT_STANDARD)*.cfg not found  

%endif 
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To implement the new (SHA_V8_02) standard: 

_MDOT_STANDARDNAME = SHA_V8_02 

_MDOT_STANDARD = $(_MDOT_WORKSPACEROOT)Standards/$(_MDOT_STANDARDNAME)/ 

%if exists ($(_MDOT_STANDARD)*.cfg) 

%   include $(_MDOT_STANDARD)*.cfg 

%else 

%   error Exiting, $(_MDOT_STANDARD)*.cfg not found  

%endif 

As mentioned in FAQ 10, mixing the SHA workspace with your corporate 
workspace can have unanticipated results. It may be worthwhile to generate a 
debug file using both methods (standard shortcut vs. PCF edit) and perform a 
detailed comparison to ensure that essential variables are properly set. 

 

Notes 

1. As stated earlier, this workspace is a complete replacement of the previous 
workspace. However, its files should be placed in a completely different 
location. The previous workspace should be left as-is to allow reverting back 
to it, should it become necessary. 

2. The previous (old) workspace as implemented 
uses UCF files (User-based) to implement the 
V7 or V8 standards.  

 

3. The new workspace has relocated this control 
to PCF files (Project-based). Additionally, there 
is no longer a V7 workspace.  
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4. Within the new Workspace, access to its version of the previous (old) 
standard is accomplished using the SHA_V8_01 Project. 

a. Except for minor technical revisions, the “SHA_V8_01” standard is 
identical to the current “MDSHA_V8_01” standard in all important 
respects (levels, cells, standard files, barmenus, etc.). 

5. Within the new Workspace, access to its 
version of the new CADD standard is 
accomplished using the “SHA_V8_02” 
Project.  

a. While its overall appearance will be similar to the V8_01 standard, 
there are significant changes to many of the settings and workflows. 
Many of these changes are necessary either for the Open Roads parts 
of InRoads V8i (SELECTseries 4) or are in anticipation of the eventual 
migration to Bentley Connect Edition software. 

b. All scaling of Text, Cells and Line Styles are controlled by the 
MicroStation Annotation Scale settings. (The current workspace is only 
configured for Text).  InRoads command output continues to require 
separate scale factor. 

i. Models created in this workspace have the line style scaling 
property set to use annotation scale instead of the global line 
style scale factor. This makes it difficult to reference files from 
one standard into files in the other standard without making a 
number of significant changes to the reference files. 

 New Workspace (2.0)                                              Old Original Workspace (1.0) 
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ii. No seed files from the original workspace should be used with 
the new workspace due to this and item 5d, below. 

c. The level naming system of the V8 workspace has been replaced by a 
National CAD Standards (NCS) compliant naming convention. It is very 
similar to the ones used at most federal agencies, WSSC, the US Army 
COE and the MDOT MAA and MPA. 

i. The workspace uses Element Templates, ByLevel Symbology, 
Sheet Models, Drawing Models, Annotation Cells and more. The 
ByLevel implementation within this release has been applied to 
a limited number of Element Templates. Future updates are 
planned to expand these numbers significantly. 

ii. This workspace is configured and optimized for use with Bentley 
InRoads V8i (SELECTseries 4) with Open Roads Technology. 

d. All seed files or standard DGN files in both the SHA_V8_01 and  
SHA_V8_02 Project workspaces have had their global origins reset to 
the center of the design plan/cube. This is necessary for any tools that 
generate sheet models and files. 

New Old 
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i. It is anticipated that many of these sheet generating tools will 
be accomplished entirely within a Bentley product in coming 
releases and these require an unshifted global origin. 

ii. This allows Print Sheet files to be defined as Sheet Models and 
to also allow the SHA Border Reference file to be assigned as the 
Border Attachment, linking the Border Reference file and Sheet 
Boundary. 

6. In the previous workspace, there was a common folder (MDSHA_Common) 
for files that could be shared by V7 and V8_01 standards. That folder has 
been replaced by a new common folder (SHA_Common) that is for files that 
can be shared between the V8_01 and V8_02 standards.  

7. The new workspace will keep track of Workspace Release using a numbering 
system consisting of Major.Minor.Patch. Because the workspace contains 
two CAD standards, the Standards Version use a numbering system 
consisting of Standard.Major.Minor.Patch. 

a. The current workspace release is 02.01.02.  

b. As bugs are resolved in our development workspace, the Patch value 
will increment (e.g. 02.01.04).  

c. It is only upon publishing updates to SHA’s website that the Minor 
value will increment (e.g. 02.02.00).  

d. Determine the current version of your workspace by selecting MDSHA 
> Help > About Workspace 

e. All published updates that include changes to standard files (such as 
the border) are anticipated to include updates for both the V8_01 and 
V8_02 standards for the time being. 
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8. The new workspace relies on the use of the mcm.user.cfg file introduced by 
ProjectWise. Its use and contents are explained in the link found on the 
Collaboration Technologies / IDS web page -  How to Integrate MicroStation 
with ProjectWise (3/30/2018). The ProjectWise help documents contain 
additional information about this file. The copy of the file delivered with 
ProjectWise (See FAQ #12) also contains additional documentation. 

9. In General, InRoads Ss2 should be used with the SHA_V8_01 standard and 
InRoads Ss4 should be used with the SHA_V8_02 standard. At this time, the 
SHA_V8_01 standard does not contain the necessary configuration to 
support InRoads Ss4.  

10. MDOT SHA has begun using Power InRoads as its platform, but the 
workspace should still work with a MicroStation with InRoads platform. 

https://www.roads.maryland.gov/Index.aspx?PageId=686
https://www.roads.maryland.gov/ohd/MicroStation_Integration_with_ProjectWise_V8i.zip
https://www.roads.maryland.gov/ohd/MicroStation_Integration_with_ProjectWise_V8i.zip
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